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• Manage Target

• Remote Control

• Corvina Cloud

• JavaScript

• CODESYS internal PLC

• Direct access to I/O from JMobile

• Send Email

• Custom Widgets and User Gallery

• Keypad customization

• User Management customization
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Agenda
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Manage Target

• Manage Target has
three tabs

• To manage projects and operate on Runtime
operations

• To activate CODESYS v3 License

• To get Board info and upload/download
system components
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• List of stored projects

• Load and unload projects
• Red icon > project is unloaded

• Blue icon > project is loaded

• Delete projects to free space

• Upload projects *

5

Manage Target - Runtime

* Copy project from HMI to PC. 
HMI Can be password-protected to prevent “unwanted” uploads
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Manage Target - Runtime

• Update Runtime

• Restart Target

• Access to Update Package window

• Change target listening ports *

• Download System Files to apply

* Useful when target is Runtime PC and default HTTP port (80)
is already used by other programs
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Manage Target - License

• Insert HMI IP Address 
or search from list

• Insert Activation Key *

• Click on Activate/Generate

* Activation Key can be:

• Final License: ask to sales

• Demo License: insert “CODESYS_DEMO” to have a 2 hours 
running PLC. To restart demo license, HMI requires reboot
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• Update OS components via Ethernet

• Useful to retrieve OS components info

• Useful to replace HMI splash
screen shown during
power-up phase
• type: 16bit bitmap 

• filename: splash.bmp

• size: less than 500 KB

• resolution: even on width and height

7

Manage Target - Board
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Remote Control overview

download
upload

HMI
with JM Runtime and Project

JMobile Client

JM4Web

FTP Client

VNC Client

Remote Desktop

Http pages

Native client
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Remote Control - Clients comparison

Server
JMobile Client

JM4Web

HMI

Client

up to 3 connections

VNC Client



©2018 EXOR International S.p.A. All rights reserved

• Any action executed on HMI screen is viewed in VNC Client and vice-versa

• Sends graphic frames and click commands based on VNC standard protocol

• Useful to “teach” end user to operate on HMI application

• Different procedure to enable VNC Server on HMI, based on Operative System

• Windows CE  

• Linux

11

VNC
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• Set VNC Plug-in to “true”

11

VNC (WCE)
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• Run > 
Manage Target > 

Update Runtime

11

VNC (WCE)
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• Execute
“LaunchVNC”
action on Button

11

VNC (WCE)
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• Configure VNC Server

11

VNC (WCE)
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• From System Settings

• Context menu: directly on HMI

• Browser:
https://<ipAddress>/machine_config
https://<ipAddress>/system_settings

12

VNC (Linux)
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VNC (Linux)
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• What is:
• JMobile Client is an application included into JMobile Suite installer package

• Run only on Microsoft Windows OS machines

• How it works:
• Same application running on the HMI will be loaded in JMobile Client

• Acts as a remote client, sharing local visualization with those Tag values maintained or updated by 
communication protocol

• Page currently viewed on JMobile Client could not be the same currently viewed on HMI

13

JMobile Client
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• Access from JMobile Client is secured by "Force Remote Login"

• Once launched, you need only to type-in HMI address

14

JMobile Client
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• JM4Web provides a new real-time interface
to the HMIs using standard web technologies

• Run on HTML5 web browsers

15

JM4Web
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• Different size web to differentiate devices

• Desktop

• Smartphone

• Tablet

15

JM4Web
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• Native pages can be converted to web pages

• Pages are moved, not copied

• To copy pages:

• Duplicate Native page

• Convert page

15

JM4Web

NEW
in 2.8
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JM4Web

• All common widgets are supported in JM4Web

• With some limitations, reported in Help:

Web access > Web supported features 

Examples:

• Scheduler widgets

• Not-modal dialog pages

• Custom keypads

• Multistate Image Multi-Layer widget

• …..
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JM4Web

• Choose pages for each device

• Set specific Home page
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• After project download, web page are
reachable from browser, pointing to

http://<IPAddress>

• If HMI is not available, web pages can be
reached also in Simulation

http://<IPAddress>:81

17

JM4Web
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• Enable FTP Server on HMI 
to get access to the internal flash disk data

• Any standard FTP Client can be used

• FTP access is disabled by default and
must be enabled into Group Authorization
settings:
• "Enable FTP authorization"

• "Root Folder" can be set as per needs

• Allowed only ONE connection at a time
pay attention on FileZilla Client!

18

FTP Client
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• Is possible to map “USB Memory”
or “Storage Card” as FTP Folder

• USB Memory and SD Card will
become accessible by
FTP connection

• Very useful to retrieve Alarm, Trend 
or Recipe files dumped into external
memories

19

FTP access to external memory
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FTP access to external memory
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Corvina Cloud is the EXOR International solution for
Remote Control and Teleassistance, based on secure VPN and Web access

21

What is Corvina Cloud
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VPN can be opened using Corvina Cloud App

21

Corvina Cloud App
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Web access is available connecting to corvinacloud.com

21

Web Access
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• Reduces costs of maintenance and support

• Provides connectivity for new or existing plants

• Provided by same HMI manufacturer (native solution)

• Completely accessible and configurable from browser

21

Why using Corvina Cloud
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• Separated Ethernet interfaces

• One can be dedicated for remote control,
others can be logically separated and 
dedicated to communication with PLC

• Cloud service configurable from
web browser

21

Corvina Cloud solutions – eX700 series
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• One single Ethernet interface*

• Can be dedicated for remote control,
and communication with PLC

• Cloud service configurable from 
web browser

21

Corvina Cloud solutions – eSMART series

* Valid for eSMART04/07M/10 while eSMART107 has 2 Ethernet interfaces 
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• One single Ethernet interface 
2 Ethernet ports

• Can be dedicated for remote control,
and communication with PLC
using HMI Cloud Enabler

• Configurable from HMI

21

Corvina Cloud solutions – eTOP500/600 series
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• Secure Cloud Connector with 
2 separated Ethernet interfaces

• One can be dedicated for remote control,
others can be logically separated and 
dedicated to communication with PLC

• Cloud service configurable from
web browser

• Can be mounted on existing plants to give
connectivity to eTOP500/600 HMIs

21

Corvina Cloud solutions – eTOP500/600 and PLCM07
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• Separate Networks:
• WAN = Internet / Corvina Cloud

• LAN  = HMI / PLC local network

21

Corvina Cloud solutions – eTOP500/600 and PLCM07

WAN - 192.168.40.4

LAN - 172.16.10.1

HMI - 172.16.10.10

PLC - 172.16.10.11
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• Username and password to 
access to Corvina Cloud
are provided by Exor

21

Access to Corvina Cloud
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• Username and password to 
access to Corvina Cloud
are provided by Exor

• Click on gear icon to insert 
credentials
• Possibilty to define different

access profiles

21

Access to Corvina Cloud
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• Username and password to 
access to Corvina Cloud
are provided by Exor

• Click on gear icon to insert 
credentials
• Possibilty to define different

access profiles

• Same credentials can be inserted
in corvinacloud.com

21

Access to Corvina Cloud
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• From Device tab

click on Add gateway

21

Add a Device
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• Fill details in Gateway tab:

• Name

• Organization

• Password

• Activation code

21

Add a Device
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• About device authentication
use one of the following 
syntax to authenticate device

• Name@Organization

• Name/Organization

21

Add a Device
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• Serial Number field is
used to certificate Device
in Corvina Cloud server

• For eX700, eSMART, eTOP 
(and all HMIs with display)
HMI Cloud Enabler 
activation code must be used

• For eXware, PLCM07
Serial Number printed on 
HMI label must be used

21

Add a Device
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• Configure Endpoints

• Definition of any network point
to be reachable from remote

• Possibility to open an entire
network segment with
Local network field
using CIDR notation

Example: 192.168.100.0/24

21

Add a Device
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• Possible to show endpoints
as CSV for easy copy/paste
between devices

21

Add a Device



©2018 EXOR International S.p.A. All rights reserved

• From web browser go to
https://<IPaddress>/machine_config

21

Configure HMI service
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• Enter in Edit mode

• Switch to Enabled

• Insert Username* and Password

• Save

21

Configure HMI service

* Use one of the following syntax
Name@Organization
Name/Organization
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• In eTOP500/600 series (WCE-based)

Credenentials must be entered in HMI

from HMI Cloud Enabler

21

Configure HMI service
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• Use Applications as a way 
to recall common usages
in remote connections

• Any external application

• Embedded VNC and
JM4Web (also from web access)

21

Configure Applications
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Different type of Applications:

• SSH: open an SSH session

• RDP: open a Remote Desktop Win32

• VNC: open a standard VNC connection

• Telnet: open a Telnet session

• HTTP/S: open HTTP/S session

• Custom: open external program

21

Configure Applications
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• To use Applications 

• Profiles must be created as 
group of Applications

• Assigned to any Endpoint

21

Assign Applications to Endpoints
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• JM4Web Application
to point to JMobile web pages

• Available from

• Corvina Cloud App

• Web portal 
(smartphone, tablet
desktop browser)

21

Use Cases – JM4Web
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• VNC Application
to point to HMI display

• Available from

• Corvina Cloud App

• Web portal 
(smartphone, tablet
desktop browser)

21

Use Cases – VNC
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• System Settings Application
to point to HMI System Settings *

• Available from

• Corvina Cloud App

• Web portal 
(smartphone, tablet
desktop browser)

21

Use Cases – System Settings

* For Linux-based HMI only
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• JMobile Client Application
to point to JMobile Runtime
usinf Navite Client

• Launches 
exernal application

21

Use Cases – JMobile Client
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• File Transfer Application
for easy remote/local file
management

• Uses a built-in application inside
Corvina Cloud server

21

Use Cases – File Transfer
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• SSH Application
to open Linux shell *

• Uses a built-in SSH Client

21

Use Cases – SSH

* Useful for debugging purpose. No need to install SSH Client on PC.
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• Users can be added and can have
different Permissions

• Managers can add/remove items

• Regular users can view items

21

Add Users
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• Fill details in User tab

• Name

• Organization

• Password

21

Add Users
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• Fill details in Permissions tab

• Choose specific persmissions
to give to user

21

Add Users
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• From device configuration
it is possible to specify user
permissions from Permissions tab

• Same concept can be applied
to user groups and devices groups

Example:
Allow access to a group of device
to a group of users

21

Specify permissions on devices
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• A JavaScript function is executed when an event occurs.
For example, a user can define a script for the OnMousePress event.

• Evaluate carefully execution of JavaScript function at a given scan rate 
with a scheduled action.
This approach minimizes the overhead required to execute logic on the HMI.

• JavaScript engine run at the client side.
Each client connected to the server side of JMobile Runtime 
(could be the client resident on HMI, or a JMobile Client) 
will run the same script, providing output results that depend by client

30

Javascript
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• JavaScript Action called on Events

• Widget Events
• OnMouse event

• OnDataUpdate event

• Page Events
• OnActivate

• OnDeactivate

• System Events
• Schedulers

• Alarms

31

Events
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• JMobile Studio uses JavaScript objects to access the elements of the page. 
Each object is composed of properties and methods.

32

Objects

Objects Description

Widget The Widget class is the base class for all elements on the page

Page
This object references the current HMI page. The page is the top-level object of 
the screen

Project
This object defines the project widget. The project widget is used to retrieve 
data about the project such as tags, alarms, recipes, schedules and so on. 
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• Project Methods for pages

• nextPage: project.nextPage();

• prevPage: project.prevPage();

• homePage: project.homePage();

• loadPage: project.loadPage("Page5.jmx");

• showDialog: project.showDialog("Dialog.jmx");

• closeDialog: project.closeDialog();

• showMessage: project.showMessage("Hi This is test message");

33

Project Object
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• Project Methods for tags

• object  getTag(tag name, state object, array index)
var tagvalue = project.getTag("Tag1", state, 0);

• number  setTag( tag name, tag value, [array index], [forceWrite])
project.setTag("Tag1", tagvalue);

34

Project Object
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• Page Methods for properties

• object  getProperty(property name)
var page_height = page.getProperty("height");

• number  setProperty(property name, property value)
page.setProperty("color", "rgb(255,0,0)");

• Page Method for widgets

• object  getWidget(widget Id) 
var shape = page.getWidget("rect1");

35

Page Object
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• Widget Methods for properties

• object  getProperty(property name)
var shape = page.getWidget("rect1");

var W = shape.getProperty("width");

• number  setProperty(property name, property value)
var shape = page.getWidget("rect1");

shape.setProperty("width", 350);

• NOTE: When you Set properties via JS you have to set the Static Optimization property to 
Dynamic, otherwise changes will be ignored

36

Widget Object
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Javascript Example
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• The global variable "project", can be used to share JavaScript code between pages

• Variables and functions created into Project Properties tab, can be recalled from other project 
pages

33

Javascript: shared code
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• Access to resources
• HMI Flash memory: “/Flash/QTHMI”

• USB Stick: “/USBMemory”

• SD Card: “/Storage Card”

36

Javascript: read/write files
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• QT Script debugger

40

Javascript Debug



CODESYS 
internal PLC
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• CODESYS is a development environment for programming controller applications according to 
the IEC 61131-3

• IEC 61131-3 is the third part of the open international
standard IEC 61131 for PLC

• IEC 61131-3 deals with programming languages and defines three graphical and two textual 
PLC programming language standards:
• Ladder diagram (LD)

• Function block diagram (FBD)

• Structured text (ST)

• Instruction list (IL)

• Sequential function chart (SFC)

43

CODESYS as IEC 61131-3
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Programming Languages

Sequential
Function Chart (SFC)

Function Block
Diagram (FBD)

LD A

ANDN B

ST C

C:= A   AND  NOT  B

A   B                    C

-| |--|/|----------------(  )

AND

A                         C

B

Step 1               N      FILL          

Step 3

Step 2                S     Empty          

Transition 1

Transition 2

Ladder Diagram (LD)

Structured
Text (ST)

Instruction
List (IL)



©2018 EXOR International S.p.A. All rights reserved

• IEC 61131-3 predefined (or elementary) data types:

45

IEC 61131-3 Data Types

IEC 61131-3
Data Type

CODESYS
Data Type

JMobile
Data Type 

Limits Memory Space

BOOL BOOL Boolean 0 ... 1 1 bit data

SINT SINT Byte -128 ... 127 8-bit data

USINT USINT / BYTE UnsignedByte 0 ... 255 8-bit data

INT INT Short -32768 ... 32767 16-bit data

UINT UINT / WORD UnsignedShort 0 ... 65535 16-bit data

DINT DINT Int -2.1e9 ... 2.1e9 32-bit data

UDINT
UDINT / 
DWORD

UnsignedInt 0 ... 4.2e9 32-bit data

LINT --- --- -9.2e19 ... 0.2e19 64-bit data

REAL REAL Float 1.17e-38 ... 3.40e38
IEEE single-precision
32-bit floating point type

LREAL --- Double 2.2e-308 ... 1.79e308
IEEE double-precision
64-bit floating point type
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• Project
• A CODESYS Project contains all of the objects in a PLC program.

• The following objects are included in a project:
• Data types,

• POUs (Program Organization Units),

• Resources,

• Libraries.

• Data types
• Along with the standard data types the user can define his own data types. Structures, enumeration types 

and references can be created.

46

What is what in CODESYS
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• POU (Program Organization Unit)
• Each POU consists of a declaration part and a body.

• The body is written in one of the IEC programming languages.

• POUs can call up other POUs but recursions are not allowed.

• POUs can be divided in three types:
• Function: it is a POU, which yields exactly one data element (which can consist of several elements, such as fields or 

structures)

• Function Block: it is a POU which provides one or more values during the procedure. As opposed to a Function, a 
function block provides no return value.

• Program: A program is a POU which returns several values during operation. Programs are recognized globally 
throughout the project. All values are retained from the last time the program was run until the next.

• PLC_PRG: The PLC_PRG is a special predefined POU. Each project must contain this special program. This POU is 
called exactly once per control cycle.

47

What is what in CODESYS
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• Resources
• You need the resources for configuring and organizing your project and for tracing variable values. 

Resources are PLC Configuration, Target Settings, Workspace, Global Variables, Library manager…

• Libraries
• You can include in your project a series of libraries whose POUs, data types, and global variables you can 

use just like user-defined variables.

48

What is what in CODESYS
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• Multi PLC
several controllers can be programmed simultaneously in one single project

• Multi selection in the project tree
operation affects all selected objects

• Customizable user interface

• Import/Export via PLCopen XML format

• More fieldbus protocol stacks
EtherCAT, Profinet, Ethernet/IP, PowerLink (in addition to Modbus TCP/RTU and CANOpen)

• Support for eSMART and 700 series (Linux)

49

What is new in CODESYS v3
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• exorint.com

• Support

• JMobile
Documents and Download

63

CODESYS v3: get software

NOTE: CODESYS v2.3 is not 
compatible with CODESYS v3.5
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CODESYS v3: software installation
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CODESYS v3: software installation
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CODESYS v3: software installation
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CODESYS v3: software installation
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CODESYS v3: install package
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CODESYS v3: install package
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CODESYS v3: install package
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CODESYS v3: install package
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CODESYS v3: install package
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• Exor package for CODESYS v3 can be installed:

1. With double-click on package file

2. From CODESYS v3 software going to
Tools > Package Manager > Install

66

Install package - remarks
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CODESYS v3: create a new project
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CODESYS v3: create a new project



©2018 EXOR International S.p.A. All rights reserved

CODESYS v3: create a new project
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CODESYS v3: create a new project



©2018 EXOR International S.p.A. All rights reserved

CODESYS v3: create a new project
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CODESYS v3: create a new project
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• Select the device based on HMI series:

• 500/600 (WCE)
for eTOP504, 506, 507, 507G, 507M, 507MG, 510, 510G, 512, 513, 515, 515G and eTOP605, 607M, 610

• 600L/700 (Linux)
for eX705, 707, 710, 715, 721, eXware, eSMART107

• eSMART (Linux)
for eSMART04, 07M, 10

68

Create a new project - remarks
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CODESYS v3: symbol configuration
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CODESYS v3: symbol configuration
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CODESYS v3: symbol configuration



©2018 EXOR International S.p.A. All rights reserved

CODESYS v3: symbol configuration
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CODESYS v3: symbol configuration
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CODESYS v3: symbol configuration
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• Right-Click on Application, then select 
Add Object > Symbol Configuration...

• Inside Symbol Configuration click "Build"

• Go to Build > Generate code to generate the .xml file
xml file is used as the tag import file to bring all selected variables into the JMobile project

• OPTIONAL: select "Support OPC UA features" to expose symbols via OPC UA Server
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CODESYS v3: download to PLC
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• Online > Login
will open a dialog box to confirm the download to the PLC.
At that time, the code is in RAM. A restart of HMI will erase
the PLC code

• Online > Create boot application
will save the PLC application to flash

• Debug > Start
will put the PLC in Run mode
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• Add CODESYS v3 ETH protocol

• Configure PLC IP address as 127.0.0.1

• Import tags from symbol file ".xml"
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• Users can access and control PLIO06/PLIO07 without needs of CODESYS v2 or v3 
internalPLC

• Useful when there's no needs 
of programmed logic 
Example: open/close relay 
with a JMobile button

• Define "System Variables"
protocol and select
"Direct I/O"
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• The number after #  identify the slot where PLIO06 is plugged in

• For PLIO06 we can access:
• Inputs (array of 8 bit)

• Diags (array of 3 bit)

• Outputs (array of 7 bit)

• To drive a single output
you MUST use Tagindex
property on "Attach To"
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Direct access to I/O

PLIO06 slot #1

PLIO06 slot #2

PLIO06 slot #3

PLIO06 slot #4
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• With action "SendEmail" HMI will send an email on events

• Set email server configuration in "EmailConfig"
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• Email configuration can be set
in “EmailInfo”
• From

• To

• Subject

• Attachments 

• Body of email

• All of the above can be
attached to Tag

• To use an external email server
HMI must have access to Internet.
Check Gateway and DNS 
on HMI Network Settings
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• Group many Widgets, 
then convert to Custom Widget
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• Create your own Widget Catalog

84

Custom Widgets



©2018 EXOR International S.p.A. All rights reserved

• Create your own Widget Catalog

• View where Custom Widgets are used
in the project

84

Custom Widgets



©2018 EXOR International S.p.A. All rights reserved

• Create your own Widget Catalog

• View where Custom Widgets are used
in the project

• Set inheritance configuration

84

Custom Widgets



©2018 EXOR International S.p.A. All rights reserved

• Create your own Widget Catalog

• View where Custom Widgets are used
in the project

• Set inheritance configuration

• Expose custom properties, categories 
and parameters

84

Custom Widgets



©2018 EXOR International S.p.A. All rights reserved

• Create your own Widget Catalog

• View where Custom Widgets are used
in the project

• Set inheritance configuration

• Expose custom properties, categories 
and parameters

84

Custom Widgets



©2018 EXOR International S.p.A. All rights reserved

• Inheritance allows to create a Widget model

• All changes will be applied in all instances
(all over the project)

• Inheritance types:  

• Only Graphic

• Only Logic (embedded JS code)

• Full (Graphic + Logic)
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Inheritance

NEW
in 2.8



©2018 EXOR International S.p.A. All rights reserved

• Inside Widget Gallery there is "User Widgets" 
to store custom widgets

• To save a custom widget, select the edit button
and copy it into “myGallery1” page

• User can add/remove a personal gallery selecting
[+] or [-] buttons

• A personal gallery can be shared with other users
Personal Gallery by default is placed under
JMobile Workspace directory
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• Default keypads   
• Alphabet

• Calendar

• Numeric

• Converting project from a target device to another with
different screen size, default keypads will be changed accordingly
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• Alphabet and Numeric can be changed as per your needs

• Additional keypads can be included into the project
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• User Management templates refers to project pages that comes out into Runtime when
• Performing a login

• Performing a switch user

• Opening User Editor

• Adding user

• Deleting user

• Changing password

• These pages are included
into every project under
UserMgmtTemplates folder
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• Open page with JMobile Studio

• By drag and drop files>
into JMobile application

• Going to File > Open
and selecting *.jmx 
as filename

• Pages can be changed as per needs
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• It is possible to change "Login page" and
"Switch user page" with a version
with a combo box for username
• Useful to avoid to type username

every time

• In order to be effective replace
default template with the ones
named “_combo”
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End of JMobile 
Training Day 2

Thanks for your attention

Technical Support Team


